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Purpose
The purpose of this document is to show you how to use the VMware Workstation/Player to run a Fedora virtual 
machine. It is not the purpose to teach you about Fedora or Linux.

Pre-requisites
I assume that you're running a windows machine (winxp, vista, win7, win10, etc.). I also assume that you have 
about 30 GB of free space. It's also a good idea to have at least 4GB of RAM.



What is a Virtual Machine?

When you turn on your PC/laptop you interact with your computer through an OS (OS = operating system). Your 
PC/laptop is a real (i.e. physical) machine. Your OS is probably Windows XP/Windows Vista/Windows 
7/Windows 10/Windows 11.

From now on I'll say “windows” instead of “Windows XP/Windows Vista/Windows 7/Windows 10/Windows 11”.

It's possible to simulate a machine with its own operating system in your PC/laptop. You will need two things:
• A bunch of files describing a machine. This includes basically the harddrive data of an actual physical 

machine. The OS in this harddrive might be for instance Fedora. This is the virtual machine.
• A software to read the files above and executes the operating system (example: Fedora) through some 

virtual hardware in your WinXP/Windows Vista/Windows 7.
The software running the files gives you another machine, a virtual machine. It's virtual because it's not running 
in its own physical computational environment.

So if you like, you can think of a virtual machine as a machine inside a machine. From now on, I might say “vm” 
instead of “virtual machine”.

Your real/physical machine is called a host machine. The virtual machine is called a guest machine. The host 
OS is the OS of the host machine. The guest OS refers to the OS of the guest machine.

That's all you need to know. Remember that there are two things you need: the virtual machine (which is a 
bunch of files) and software to run the virtual machine.

For us, I will assume that our host OS is windows.

The virtual machine used in this tutorial is a Fedora 31 virtual machine. However everything that I say will apply 
to other versions of Fedora. From now on, I will say “fvm” instead of “Fedora virtual machine”.

The software I'll use to run the fvm is VMware Workstation 15. I will say “workstation” instead of “VMware 
Workstation 15”. (If you laptop is newer, you might want to run VMware Workstation 16 instead.)

The fvm I've built has two users, “student” and “root”. The password of “student” is “student” and the root 
password is “root”.

So here's a summary:

Host OS = winxp/vista/win7/win10/win11
Guest OS = Fedora 
Virtualization = VMware Workstation 15 (or 16 or 17 ...)

FOR MAC USERS: The VMware Workstation version for Mac is VMware Workstation Fusion. But this is not 
free. Another option is to use the VirtualBox instead of VMware Workstation. NEWS: VMware has made 
VMware Fusion free for Mac users!



Getting VMware Workstation and the Fedora Virtual Machine

VMware Workstation (previously Player) is free. All you need to do is to google for it, download the installation 
program, and install the software. Now for the fvm (Fedora virtual machine). 

You can download the fvm when you point your browser to our Software folder  ,   go into folder f31 (we have 
many Fedora virtual machines and the current one we use is Fedora 31), and download the f31.7z file. Save the 
file (it's a zipped folder). Extract the zipped folder and save it somewhere – make sure you remember the 
location. This folder contains the virtual machine.

It doesn't matter where you keep your fvm. However it's a good idea to be organized. For instance you might 
want to create a folder, say “My Virtual Machines”, and put your fvm there. When you install VMware 
Workstation/Player, it's very likely that a folder “My Virtual Machines” was created under your user folder.

It's a good idea to keep the original two files (the vmware player installation file and the zipped virtual machine 
folder) somewhere safe (example: backup on an external drive) in case of laptop failure and you need to re-
install the player and also recopy the fvm.

https://drive.google.com/drive/folders/0B7Sweg7OrVSTQUh6a0VmVnMzVm8


Running your fvm: VMware Workstation

Run workstation, go “File > Open”:

and browse to the folder containing the fvm and click on the icon:

(for f40, you’ll see f40,vmxf) or

and you'll see this:

Your workstation now remembers your fvm. To run your fvm, either double-click on the f40 in your workstation or 
select f40 and click on “Play virtual machine”.

If this is the first time you're running a vm that you copied, you will be asked if you copied the virtual machine. 
Select “I copied it” and click on “OK”. After a while you'll see this:



IMPORTANT NOTE. Note that if you want to send your inputs (keyboard inputs, mouse clicks, etc.) to the virtual 
machine, you need to first click on any part of the window for the virtual machine inside the VMware software. 
While using the virtual machine, if you want to switch back to sending inputs to your windows machine, you click 
on any part of your screen outside the workstation. 

You can also do this: Type Ctrl-G to send inputs to the fvm and Ctrl-Alt to send inputs to your host.

You can tell if your mouse cursor is under the control of the host or the guest: If the cursor is white it is controlled 
by the host (your windows); if it's black it is controlled by the guest (your fvm).



Logging in and Logging out

I'll assume that the fvm is now running (through the workstation/player). We will now login to the machine as the 
“student” user. Click on “student” and enter the password “student” (without the quotes):

 Press the enter key and you'll see this:

You are now logged in as “student”. To log out, within the fvm window click on “System” and click on “Log Out 
student” (or “Shutdown” to shutdown the virtual machine completely):



You can also close your workstation. In this case, your workstation will ask if you want to suspend or power off 
your fvm. If you suspend your fvm and you run your fvm again, it will “wake” it up and resume from when you 
suspended it. In general it’s probably best to save all your work, close all your programs, and then power off. 

If you are not logged in, you can shutdown your fvm:



Changing Password

Two things you should do now: you might want to change your student password and you should do a software 
update.

Run fvm and log in as student. Double-click on the Terminal icon on your desktop 

and you'll see the terminal window:

A terminal (also called a terminal shell or a shell and in our case it’s a “bash” shell) is a window that allows you to
execute commands in your fvm. 

In the terminal window type

whoami

(and press the enter key). and the terminal will respond with “student”. This tells you that your terminal window is
now running as the “student” user. The password of “student” is “student”. You might want to change the 
password, but it’s probably not necessary. To do that in, your terminal window type

passwd

and you will be prompted for the new password. Make sure you remember your new password for “student” user.

To change the root password, first you have to become the root or superuser. (Certain commands require you to 
be the “root” user.) In your terminal window type

su

(su = substitute user). You will be prompted for the root password – enter “root” for the root password. Once 
that's done, type



whoami

and the terminal will tell you that you are root. Now do 

passwd

to change the root password. MAKE SURE YOU REMEMBER YOUR ROOT PASSWORD!!! After the root 
password is changed, type

exit

and you become “student” again. Go ahead and enter the command

whoami

to verify. Make sure you remember the root and student password.  



Software Update and Installation (NEW: see section update-vm)

To update the software installed in your fvm, open a terminal, type su and press the enter key, enter the root 
password, and then enter this command

dnf -y update

Your fvm includes the GNU C/C++ compiler, Python, LaTeX, etc. If you want to install other software read on.

To install software, for instance the emacs editor, you do this:

dnf -y install emacs

You can install two (or more) software in the same command like this:

dnf -y install emacs gcc-g++ python

This will install both emacs, the GNU C++ compiler and python.

Remember to exit from root (and become student) once you are done installing software.

I’ll be using the emacs editor. All CS majors should start with emacs (or something equally powerful as emacs 
such as vim). If you are not a CS major, a general text editor (like your notepad in windows) you can use is 
pluma. To install pluma, as root, you execute

dnf -y install pluma

To remove an installed software, as root, you execute the following in your shell:

dnf -y remove pluma

However pluma (or other basic text editors) is not as powerful as emacs. You are at
a serious disadvantage if you use pluma instead of emacs.

The linux world is full of free linux games. You can google “free fedora games” and practice installing one.



NEW 2024 for f40: update-vm

The following update will more or less synchronize your laptop with mine. Open a terminal, type su and press the
enter key, enter the root password, and then enter this command

update-vm

After that, close the bash shell and re-open another bash shell. 

To run emacs, use the e macro in your bash shell. For instance

e helloworld.cpp &



Full Screen Modes

When you need more desktop work space you can change to near full screen mode. Play around with your 
workstation and you should be able to do it without too much trouble.



Backup

Note that your fvm is just a bunch of files. Therefore it's easy to duplicate virtual machines. You just make a copy
of the folder that contains your fvm. Before you do this, you should shutdown your fvm completely.

It's a good idea to keep a backup of a fvm that you've configured. If you accidentally damaged a fvm, all you 
need to do is to delete the fvm, make a copy of the backup, and use the copy.

You might want to backup your fvm regularly, say every weekend.



Changing Screen Resolution, Display, etc.

You can change the themes, background, screensaver, screen resolution, etc if you do “System > Preferences “
and then click on “Appearance” or “Display”.

Play around and choose what's best for you. In general, eye candy such as windows with rounded corners and 
shadows and fancy background and screensavers use more CPU time. I always choose the simplest. But this is 
up to you.



Communication with host and network connectivity

Your fvm should have network connectivity to your host and you should be able to communicate between host 
and  guest, so that you can perform file transfer between your host and guest. Go ahead try the following:

• Do a drag-and-drop of a test file from your windows desktop to the fvm desktop 
• Do a drag-and-drop of a test file from your fvm desktop to your windows desktop
• Open a text editor (example: notepad) in windows, type some text, make a copy the text, go to your fvm,

open a text editor, and do a paste of the text from windows.
• Open a text editor in your fvm, type some text, make a copy of the text, go to your windows, open a text 

editor (example: notepad), and do a paste of the text from your fvm.

Furthermore you should be able to browse the internet within your fvm. Go ahead, open your terminal, and 
execute “firefox”. 

If you can reach the internet using your firefox browser (example: you cannot go to google.com using the firefox 
web browser in your fvm), you should read on.

Go back to your windows environment and from the Start menu run “Command Prompt”. Depending on whether 
you're using winxp or win7 and the way you set up your display, it should be one of the following beginning at the
Start menu:

• Start > All Programs > Accessories > Command Prompt
• Start > Accessories > Command Prompt

This will give you a console window. In the console window type ipconfig and look for “VMnet8” and then “IP 
address”. For me it's 192.168.135.1 (your numbers might be different from mine): 
C:\Documents and Settings\yliow>ipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection:

        Media State . . . . . . . . . . . : Media disconnected

Ethernet adapter Wireless Network Connection:

        Media State . . . . . . . . . . . : Media disconnected

Ethernet adapter VMware Network Adapter VMnet1:

        Connection-specific DNS Suffix  . :
        IP Address. . . . . . . . . . . . : 192.168.233.1
        Subnet Mask . . . . . . . . . . . : 255.255.255.0
        Default Gateway . . . . . . . . . :

Ethernet adapter VMware Network Adapter VMnet8:

        Connection-specific DNS Suffix  . :
        IP Address. . . . . . . . . . . . : 192.168.135.1
        Subnet Mask . . . . . . . . . . . : 255.255.255.0
        Default Gateway . . . . . . . . . :

C:\Documents and Settings\yliow>

I will be using the “192.168.135” later. (You can also get the information when you do “Edit > Virtual Network 
Editor” in Workstation or Player.) 

Back in your fvm, do “System > Administration > Network” and you'll will be prompted for the root password. 
Enter the password for root and click on “OK” and you will see the Network Configuration window.

Click on “Edit”. (You might want to enter full screen mode to see the whole Ethernet Device window.)

Check “Activate device when computer starts” and in “Primary DNS” enter “192.168.135.2” (the first three 



number “192.168.135” was from an earlier step – obviously use your numbers if they are different from mine – 
and the last number in “192.168.135.2” must be 2) and click on “OK”:

Close the Network Configuration window and you will be prompted to save the changes. Click on “Yes” and then 
“OK”. 

Restart your fvm, log in as student, open a terminal and enter the command

ifconfig

In the output, under “eth0” section, look for “inet addr”. This will be the IP address of your fvm. For instance my 
IP address is 192.168.135.156. Your IP address is probably a different number.

Now we test if your windows machine can communication with your fvm. Back in your windows environment, at 
the command prompt type 

ping 192.168.135.156

(make sure you use your number) and you'll get some output telling how much time it takes to communicate 
between your host and the guest.

This tells us that your Windows machine and fvm can communicate.

(This means that you can use any file transfer program such as WinSCP or FileZilla to do file transfer between 



your host and your guest. In your host, run WinSCP or FileZilla and enter the IP address of your host for host 
machine.)

Finally do this test: make sure your windows machine is connected to the internet and open the firefox browser 
in your fvm by clicking this icon 

and go to google.com.



VMware Tools: Drag and Drop between Host and Guest

VMware tools is not part of the Fedora operating system. You don't need it to run Fedora. However it's useful for 
the following reasons:

1. It allows drag-and-drop between host and guest
2. It allows copy-and-paste between host and guest.

Besides the above, VMware tools also improve mouse response, etc.

You can drag-and-drop files/folders and copy-and-paste files/folders between the host and guest. You can also 
copy-and-paste text between your host and guest. This is because I've installed the “vmware tools” on the fvm.

There are cases where vmware-tools won't work. This can happen if you upgrade your player or when you 
perform certain software updates to your fedora vm. You are advised NOT to upgrade your player or reinstall 
your vmware tools if your drag-and-drop between host and guest works. If your vmware-tools really does not 
work, read on.

In the Workstation/Player, do “VM > Install VMware Tools ...” (see top menu bar). Notice that a CD/DVD called 
“VMware Tools” is placed into your virtual CD/DVD drive – you can see it on your Desktop. Execute the following
in a terminal window:

su
mkdir /tmp/xyz
cp /media/VMware\ Tools/*.gz /tmp/xyz
umount /media/VMware\ Tools
cd /tmp/xyz
gunzip *.gz
tar -xf *.tar
cd vmware-tools-distrib
./vmware-install.pl --default
cd ../..
rm -rf xyz

Restart your vm.

Window resizing. You will notice that when you maximize or minimize or change the size of your VMware 
Workstation window, the fvm desktop will fit itself nicely and fill up the whole player/workstation window. Without 
VMware Tools, the fvm desktop would stay the same. (For Workstation 7, go to View pull down and you'll see 
some Autofit options.)

Drag-and-drop. Create a text file helloworld.txt (with “hello world” as content) in your Windows environment and 
put in on your Windows desktop. Drag-and-drop the text file from your Windows desktop all the way onto your 
fvm desktop and then from the VM back to your Windows. Without VMware Tools you cannot drag-and-drop 
between host and guest.

Copy-and-paste text. Open the text file helloworld.txt in fvm (double-click and click on Display). Copy the word 
“hello” in the document. Now go to your Windows environment, open a document, and do a paste. You will see 
that the word “hello” is pasted. Without VMware Tools, you cannot copy-and-paste text between host and guest.

Unity mode. Run the terminal in the fvm. In workstation/player, do “View > Unity” or “Virtual Machine > Enter 
Unity” (see the top menu bar of workstation/player). You will notice that your workstation/player minimizes, and 
the terminal window that was inside the fvm appears on your Windows environment.

Unity mode is useful because it saves you some computer screen real estate when you need to interact with 
both Windows and Fedora environment. Just run the Fedora programs you need, enter Unity mode and work 
with those programs and your Windows programs. This will make it easy for instance to watch email using 
Outlook Express mail in Windows and write programs in Fedora at the same time.

To stop Unity, just maximize your workstation/player window and click on “Exit Unity”.



Upgrade. If you upgrade the version of your VMware workstation/player, you will probably need to upgrade 
VMware tools. VMware workstation/player will usually remind you: a window at the bottom of the window of the 
software will pop up and ask you to install VMvware Tools. You basically need to go through all the above steps 
to reinstall VMware Tools.



Accessing External Storage Devices

At the bottom right of your player, you will see something like this:

This is a list of devices your player can access. If you point your mouse cursor to any of the icons, player will 
show you the name of the device. In particular, in the above picture, the icon that is second from the right is the 
icon for my external hard drive. (It's also the same icon for your USB jumpdrive.) When I right-click on the 
external storage icon, I get this:

This gives me the option of connected the storage device to the fvm (and therefore disconnect from my host.) In 
other word either the host or the guest can access the storage at any time and not both. If I click on “Connect 
(Disconnect from host)”, an icon for the storage device will appear in your fvm's desktop. You can then access 
the external storage from from fvm.

When you're done access your external storage device from your fvm, you go to the bottom right of your player, 
right-click on the external storage icon:

and select “Disconnect (Connect to host)”. Your host will then have access to the external storage.



Shared Folder

You can make your folder in your host “appear” in your fvm so that you can access the host folder inside your 
fvm. This feature is provided by VMware Tools. (Note that shared folder might not work for all versions of 
Fedora.)

For me, I actually store all the files is use in fvm in my host (Windows). I have hardly anything stored in my fvm. 
However you should be aware that reading/writing files through a shared folder will slow down your fvm a bit. But
it will definitely make it easy for backups if you want to backup that shared folder.

In the following, I’m going to share my “Documents” folder in Microsoft Windows with my fvm. This means that 
“Documents” will appear as a directory inside my fvm. Also, if after doing all the steps, you don’t see that shared 
folder, then you’ll need to execute a command later (because of the version of your vmware workstation). So 
make sure you read this section will the end.

OK. Let’s go.

In your player do Virtual Machine > Virtual Machine Settings to get this:

Click on the “Options” tab and then “Shared Folders”:



and then click on “Add...” to get this:

Click on “Next >” 



Click on “Browse” to select the folder on your host to make it shareable with your fvm and then give it a name.

Click “Next”, then “Finish” to get this:



Click on “OK”. Reboot your fvm and login. In your fvm click on “Computer”:

then “File System”:

and then click on the “mnt” folder:

and the click on the “hgfs” folder:

and you will see the “host” folder:

If you double click on the “host” folder you will then see all the contents of your shared folder. To make it easy to 
get to this folder, you might want to make a “shortcut” to it and put this “shortcut” on the desktop of the fvm. 
Here's how to do it:



Open your terminal and type the following command:

ln -s /mnt/hgfs/host Desktop/host

You will see the following on your Desktop:

When you double click on this icon, you should see all contents of your Documents folder on your host. (This 
“shortcut” in linux is called a symbolic link or “symlink”.) 

This will allow your fvm to read your source programs (C++/Java/Python/etc.) in your host but compile with the 
compilers in your fvm.

After following all the above steps if you don’t have a shared folder, do the following. 

You’ll need to execute the following bash shell commands as root. So in your bash shell login as root by enter 
“su” and then enter your root password. After that execute these commands in your shell:

umount /home/student/shares
rmdir /home/student/shares
mkdir /home/student/shares
/usr/bin/vmhgfs-fuse .host:/ /home/student/shares -o subtype=vmhgfs-fuse,allow_other
ln -s /home/student/shares/host  /home/student/host

Exit from root by entering “exit” in your shell. You are “student” again. After the above commands the directory 
“/home/student/host” is actually not a directory but a link to the “Documents” folder in your Microsoft Windows.

Note that you’ll need to execute the above commands every time you login to your fvm. So it’s better to save the 
commands somewhere. For me, I create a text file named “share.sh” in my home directory and put the above 
commands into this file. After that I make this file executable by doing

[student@localhost ~]$ chmod a+x share.sh

After this is done, every time you restart your fvm, you become root (by doing “su”) and then run share.sh by 
doing

[root@localhost ~]$ ./share.sh

VMware shared folder features has changed throughout the years. The above extra steps is not necessary 
before (I think) version 12. The above extra steps has been tested and works for version 14-16.
 
By the way, it’s possible to get your fvm to auto-execute the above commands when you login to “student”. I’ll 
leave that as a challenge to you.



FAQ

When I try to play the Fedora VM, I get the “Failed to Lock the File” error. What should I
do?

You might see something similar to the following window when this happens:

Try to play the virtual machine a couple of times. If the problem does not go away, go to the folder containing 
your fedora virtual machine and delete all .lck files and folders.

When I try to play the Fedora VM, I get the error message "This virtual machine 
appears to be in use. …" What should I do?

You probably already have a running fvm. If not, go to the folder containing your fedora virtual machine and 
delete all .lck files and folders.

My virtual machine seems be frozen. When I click on it, the mouse cursor/pointer does 
not show up. 

Like a real machine, you can also turn the power off on your virtual machine. From the top of the vmware player, 
do Virtual Machine > Power and you'll see some options. You can power it off and then on again. Or you can do 
a reset to reboot the machine.


